AUTHORS:

Ken Jensen (Raytheon Information Solutions)

SYSTEM TEST PLAN GUIDELINE
VERSION HISTORY SUMMARY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>No version 1.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Raytheon Information Solutions)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.0</td>
<td>Renamed DG-10.2 and revised by Ken Jensen (RIS) for version 3.</td>
<td></td>
<td>10/1/2009</td>
</tr>
</tbody>
</table>

Hardcopy Uncontrolled
## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF ACRONYMS</td>
<td>5</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>6</td>
</tr>
<tr>
<td>1.1. Objective</td>
<td>6</td>
</tr>
<tr>
<td>1.2. The System Test Plan</td>
<td>6</td>
</tr>
<tr>
<td>1.3. Background</td>
<td>7</td>
</tr>
<tr>
<td>1.4. Benefits</td>
<td>7</td>
</tr>
<tr>
<td>1.5. Overview</td>
<td>8</td>
</tr>
<tr>
<td>2. REFERENCE DOCUMENTS</td>
<td>9</td>
</tr>
<tr>
<td>3. STANDARD TABLE OF CONTENTS</td>
<td>11</td>
</tr>
<tr>
<td>4. SECTION GUIDELINES</td>
<td>12</td>
</tr>
<tr>
<td>4.1. Table of Contents</td>
<td>12</td>
</tr>
<tr>
<td>4.2. List of Figures</td>
<td>12</td>
</tr>
<tr>
<td>4.3. List of Tables</td>
<td>12</td>
</tr>
<tr>
<td>4.4. List of Acronyms</td>
<td>13</td>
</tr>
<tr>
<td>4.5. Section 1 – Introduction</td>
<td>13</td>
</tr>
<tr>
<td>4.6. Section 2 – System Requirements</td>
<td>13</td>
</tr>
<tr>
<td>4.6.1. Section 2.1 – User Needs</td>
<td>14</td>
</tr>
<tr>
<td>4.6.2. Section 2.2 – Operator Needs</td>
<td>14</td>
</tr>
<tr>
<td>4.6.3. Section 2.3 – Requirements Allocation</td>
<td>15</td>
</tr>
<tr>
<td>4.7. Section 3 – Algorithm Description</td>
<td>15</td>
</tr>
<tr>
<td>4.8. Section 4 – Test Items</td>
<td>16</td>
</tr>
<tr>
<td>4.8.1. Section 4.1 – System Components</td>
<td>16</td>
</tr>
<tr>
<td>4.8.2. Section 4.2 – Product Components</td>
<td>17</td>
</tr>
</tbody>
</table>
4.8.3. Section 4.3 – Test Data ................................................................. 17
4.9. Section 5 – Test Description.............................................................. 17
  4.9.1. Section 5.1 – Test Methods ....................................................... 18
  4.9.2. Section 5.2 – Test Environments ............................................... 18
  4.9.3. Section 5.3 – Validation of Requirements ..................................... 19
  4.9.4. Section 5.4 – System Verification ............................................... 20
  4.9.5. Section 5.5 – Validation of Operator Needs ............................... 20
  4.9.6. Section 5.6 – Validation of User Needs ....................................... 21
  4.9.7. Section 5.7 – Validation of Products .......................................... 21
4.10. Section 6 – Limitations and Risks ................................................ 21
4.11. Section 7 – List of References ...................................................... 22

APPENDIX A. EXAMPLES ........................................................................... 23
APPENDIX B. TEMPLATES ......................................................................... 24
  B.1 Cover Page Template: ................................................................. 25
  B.2 Document Header Template: .......................................................... 26
  B.3 Document Cover Page Footer Template: ....................................... 26
  B.4 Document Footer Template: .......................................................... 26
  B.5 Approval Page Template: ............................................................... 27
  B.6 Version History Page Template: .................................................... 28
  B.7 Figure Caption Template: ............................................................... 29
  B.8 Table Title Template: ................................................................. 29
  B.9 List of References Template: ......................................................... 30
<table>
<thead>
<tr>
<th>ACRONYM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATBD</td>
<td>Algorithm Theoretical Basis Document</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CIOSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Check List</td>
</tr>
<tr>
<td>CLI</td>
<td>Check List Item</td>
</tr>
<tr>
<td>CM/DM</td>
<td>Configuration Management/Data Management</td>
</tr>
<tr>
<td>CMMI</td>
<td>Capability Maturity Model Integration</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>CTR</td>
<td>Code Test Review</td>
</tr>
<tr>
<td>DG</td>
<td>Document Guideline</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Product Lifecycle</td>
</tr>
<tr>
<td>IPT</td>
<td>Integrated Product Team</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>OCD</td>
<td>Operations Concept Document</td>
</tr>
<tr>
<td>PAL</td>
<td>Process Asset Library</td>
</tr>
<tr>
<td>PBR</td>
<td>Project Baseline Report</td>
</tr>
<tr>
<td>PG</td>
<td>Process Guideline</td>
</tr>
<tr>
<td>PPS</td>
<td>Product Processing System</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>PRR</td>
<td>Project Requirements Review</td>
</tr>
<tr>
<td>QA</td>
<td>Quality Assurance</td>
</tr>
<tr>
<td>RAD</td>
<td>Requirements Allocation Document</td>
</tr>
<tr>
<td>SG</td>
<td>Stakeholder Guideline</td>
</tr>
<tr>
<td>SRR</td>
<td>System Readiness Review</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
<tr>
<td>STP</td>
<td>System Test Plan</td>
</tr>
<tr>
<td>TD</td>
<td>Training Document</td>
</tr>
<tr>
<td>TG</td>
<td>Task Guideline</td>
</tr>
<tr>
<td>UTP</td>
<td>Unit Test Plan</td>
</tr>
<tr>
<td>VCRM</td>
<td>Verification Cross Reference Matrix</td>
</tr>
<tr>
<td>VVP</td>
<td>Verification and Validation Plan</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative Institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The System Test Plan (STP) is one component of this process.

1.1. Objective

The objective of this Document Guideline (DG) is to provide STAR standards for the STP. The intended users of this DG are the personnel assigned by the Development Lead to the task of creating an STP for the project.

1.2. The System Test Plan

The STP contains the plan for testing to ensure that the requirements specified for the product processing system are satisfied by the completed system (Verification) and that the final developed system will satisfy the users’ needs and expectations (Validation). The purpose of the system test is to demonstrate, using verification and validation methods, system readiness for operations. The STP builds on the project’s Verification and Validation Plan (VVP) and Unit Test Plan (UTP).

The VVP describes the work products to be verified and validated, the requirements for each selected work product and the verification and validation methods for each selected work product. The purpose of the VVP is to support requirements development and design development by ensuring that the project requirements and system design are feasible and testable.
The UTP provides a detailed plan for testing the ability of the system’s software units to function as designed and produce output that will meet the requirements allocated to the unit components.

The STP extends the scope of the UTP, providing a detailed plan for the verification and validation of every requirement of the entire product processing system (PPS).

A separate STP is produced for each distinct product in the STAR Enterprise during the Build phase of the STAR Enterprise Product Lifecycle (EPL)\(^1\).

The initial STP is STP v1r0, produced for the Code Test Review (CTR)\(^2\). Circumstances may occur during system testing that result in a decision to revise the plan. In that case, the STP will be updated to v1.1 for presentation at the System Readiness Review (SRR).

The intended target audiences are customers, product users, requirements reviewers, code reviewers, code testers, and project managers. The STP is prepared by the project’s development team, the Integrated Product Team (IPT), under the direction of the Development Lead and in consultation with quality assurance (QA) personnel and the primary customers and users.

The STP should be developed as a Microsoft Word document. Upon approval, the approved version of the STP may be converted to an Adobe pdf file for storage in the project artifact repository.

### 1.3. Background

This DG defines guidelines for producing an STP. This DG has been adapted from Capability Maturity Model Integration (CMMI) guidelines (CMMI-DEV-v1.2, 2006). It has been tailored to fit the STAR EPL process.

### 1.4. Benefits

An STP developed in accordance with the standards in this DG assists the system reviewers in verifying that the PPS satisfies project requirements. It is therefore a

---

1 For a description of the STAR EPL, refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A).

2 Refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.
requirement that an STP be developed in accordance with the guidelines in this document. The STP will be reviewed at the Code Unit Test Review (CTR)\(^3\) to determine whether a project proceeds to the next step of the STAR EPL Build phase.

1.5. Overview

This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - References
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Appendix A - Examples
- Appendix B - Templates

\(^3\) Refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.
2. REFERENCE DOCUMENTS

**OCD: Operations Concept Document** is a project artifact that is produced by the Project development team for the PRR. The STP developer can use the information in the OCD in preparing the System Requirements section of the STP. This document will be available to approved users in the project artifact repository.

**ATBD: Algorithm Theoretical Basis Document** is a project artifact produced by the algorithm developer. The STP developer needs this to prepare the Algorithm Description section of the STP. This document will be available to approved users in the project artifact repository.

**VVP: Verification and Validation Plan** is a project artifact that describes the work products to be verified and validated, the requirements for each selected work product and the verification and validation methods for each selected work product. The STP developer can use this to prepare the System Requirements and Test Description sections of the STP. This document will be available to approved users in the project artifact repository.

**RAD: Requirements Allocation Document** is a project artifact that contains the basic and derived requirements for the work products and the allocation of the requirements to system components and product components. The STP developer needs this to prepare the System Requirements section of the STP. This document will be available to approved users in the project artifact repository.

**PBR: Project Baseline Report** is a project artifact that includes the change history, approval status, and location of every Configuration Item in the project’s baseline The STP developer needs this to prepare the Test Description section of the STP. This document will be available to approved users in the project artifact repository.

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:


**PG-1: STAR EPL Process Guideline** provides the definitive description of the standard set of processes of the STAR EPL.
PG-1.A: STAR EPL Process Guideline Appendix, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

PRG-10: Code Test Review Guidelines are the guidelines for the CTR. It is useful for the developer of STP v1.0 to understand what the reviewers will expect when reviewing the STP.

CL-10: Code Test Review Check List is the check list for the CTR. It is useful for the developer of STP v1.0 to understand the specific Check List Items (CLI) that the reviewers of the STP will be required to approve.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.

SG-14: STAR EPL Development Scientist Guidelines provides a description of standard tasks for Development Scientists, including development of the STP.

SG-15: STAR EPL Development Tester Guidelines provides a description of standard tasks for Development Testers, including development of the STP.

SG-16: STAR EPL Development Programmer Guidelines provides a description of standard tasks for Development Programmers, including development of the STP.

TG-10: STAR EPL Code Test and Refinement Task Guidelines provides a description of standard tasks for process step 10, during which STP v1.0 is developed.

TG-11: STAR EPL System Integration and Test Task Guidelines provides a description of standard tasks for process step 11, during which STP v1.1 is developed.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES

LIST OF TABLES

LIST OF ACRONYMS

1.0 INTRODUCTION

2.0 SYSTEM REQUIREMENTS
  2.1 User Needs
  2.2 Operator Needs
  2.3 Requirements Allocation

3.0 ALGORITHM DESCRIPTION

4.0 TEST ITEMS
  4.1 System Components
  4.2 Product Components
  4.3 Test Data

5.0 TEST DESCRIPTION
  5.1 Test Methods
  5.2 Test Environments
  5.3 Validation of Requirements
  5.4 System Verification
  5.5 Validation of Operator Needs
  5.6 Validation of User Needs
  5.7 Validation of Products

6.0 LIMITATIONS AND RISKS

7.0 LIST OF REFERENCES
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the STP.

The STP should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert → Reference → Index and Tables → Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert → Picture → From File function or Word’s Insert → Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.
To create a List of Tables, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.

Tables should be created with the Table → Insert → Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Research Project Plan) should be given an acronym (e.g., RPP) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

4.5. Section 1 – Introduction

The STP shall include an Introduction Section. This section shall include

- A well-defined purpose and function for the document
- Specific intended user(s)
- How the intended user(s) should use the document
- A responsible entity for generating the document
- A responsible entity for review/approval of the document
- A responsible entity for storage, accessibility, and dissemination
- A brief overview of the contents of each main section

4.6. Section 2 – System Requirements

Describe the product processing system requirements. This section should explain why the products are being produced, how the products are designed to be produced, and how the
products are intended to be used. Subsections should include User Needs, Operator Needs, and Requirements Allocation.

**4.6.1. Section 2.1 – User Needs**

The subsection for User Needs should list the identified product users and state the identified needs for each user. User needs typically include:

- Product components – data formats
- Product component quality and latency
- Tools and training for the use of products
- Delivery and notification procedures
- Support services
- Documentation

Be as specific as possible for each user. If the user needs are sufficiently diverse, use separate subsections for each user. If the user needs are mostly similar, separate the common needs from the unique needs – identifying which users each unique need applies to. In the latter case, it may be useful to use separate subsections for Common Needs and Unique Needs.

A table can be useful for presenting user needs. If the number of users is sufficiently small, a common table can be used; otherwise, use separate tables for each user. Alternatively, user needs can be presented as bulleted items.

Refer to the OCD, ATBD, and/or RAD for information on user needs. If user needs are derived from user documents, refer to them.

**4.6.2. Section 2.2 – Operator Needs**

The subsection for Operator Needs should state the organization that will operate the product processing system and state the identified operator needs. Operator needs typically include:

- Procedures for normal operations
- Procedures for special operations
- Procedures for normal maintenance
• Procedures for special maintenance
• Monitoring and diagnostic procedures
• Security procedures
• Tools and training
• Delivery and notification procedures
• Configuration management
• Documentation

A table can be useful for presenting operator needs. Alternatively, operator needs can be presented as bulleted items.

Refer to the OCD, ATBD, and/or RAD for information on operator needs. If operator needs are derived from operations organization documents, refer to them.

4.6.3. Section 2.3 – Requirements Allocation

The subsection for Requirements Allocation should explain that all user needs and operator needs have been translated into system requirements and the allocation of those requirements to system components and product components. Do not itemize project requirements and requirements allocation; instead, refer to the project RAD where these are documented. Explain that system verification entails the confirmation that the requirements specified in the RAD are satisfied by the completed product or system that consists of the system components and product components.

4.7. Section 3 – Algorithm Description

Describe the algorithm that is implemented by the product processing system. Describe the objectives of the algorithm, including the intended output data products and their intended use. State the algorithm process steps and illustrate the algorithm process flow, as documented in the ATBD. This section should explain enough of the algorithm theoretical basis to demonstrate that the algorithm is able to meet the requirements presented in Section 2.

Additional algorithm details are optional. They can be included here at the developer's discretion or by reference to the ATBD and any other pertinent documents. These details include:
4.8. Section 4 – Test Items

Identify all items that have been selected for testing. These items should be identified as verification items in the project’s VVP. It is important that the development team confirm that the planned system test items are documented as verification items in the VVP. Discrepancies must be resolved and either the STP or the VVP revised as necessary.

Each system test item must be included in the project baseline under configuration control and should be documented in the PBR. Work with STAR Configuration Management/Data Management (CM/DM) to ensure that the system test items listed in this section of the STP are included in the project baseline. This is essential to confirm test readiness.

There should be separate subsections for System Components, Product Components, and Test Data.

4.8.1. Section 4.1 – System Components

The subsection for System Components should list all system components that have been selected for the system test. System components are defined as any item that is necessary or useful for building the end-use product, but will not be delivered to customers and/or end users. System components include the elements of the software architecture, as described in the UTP. Typically, they are elements of the process flow of the software units that have been tested in the unit tests, as described in the UTP. Typically, the system test will include
the end-to-end execution of the software units, as described in Section 5.4 of the STP (see below).

4.8.2. Section 4.2 – Product Components

The subsection for Product Components should list all product components that have been selected for the system test. Product components are defined as any item that will be integrated to form the end-use product, i.e. these are the deliverable items. Typically, the product components are outputs from the end-to-end execution of the software units, as described in Section 5.4 of the STP (see below).

4.8.3. Section 4.3 – Test Data

The subsection for Test Data should list and describe all data files that will be used as input files for the system test. Files to be listed here include: “Test data” includes sensor data (real, proxy, or simulated), ancillary data, control files, parameter files, and look up tables. Files to be listed here include:

- “Test data”. These data sets include the sensor data (real, proxy, or simulated), ancillary data, control files, parameter files, and look up tables that are needed to run the system test.
- “Truth” data. These are data sets that will be used to assess the quality of the system output. Truth data sets typically contain the values of environmental or weather products that are traceable to performance requirements. Truth data sets may be real, proxy or simulated data. Explain how each real or proxy truth data set has been obtained. Explain how each simulated truth data set has been constructed.

Typically, the system test will use some or all of the same test data and truth data that was used for the unit tests. In that case, information on this data can be obtained from the UTP. If the system test includes new test data in addition to the unit test data, add a description of this data to the STP.

4.9. Section 5 – Test Description

Describe the tests that are planned for the verification and validation of the product processing system. Information in this section should draw from, and be consistent with, the project VVP. Subsections should include Test Methods, Test Environments, Validation
4.9.1. Section 5.1 – Test Methods

The subsection for Test Methods should describe the test methods that will be used. Test methods should be closely related to the verification methods that are documented in the VVP. The standard methods include Analysis, Demonstration, Inspection, and Test. Note that unit test methods are not restricted to “Test”. The “Test” verification method refers specifically to a procedure to quantitatively demonstrate compliance with performance specifications. Although test methods will often include “Test” methods for verifying quantitative requirements, they can also include, and usually will include, other methods for verifying other requirements. Note which test items will be verified with each method or combination of methods.

Demonstrate that the methods selected for verification of a given item will address the requirements to be verified for that item. The project’s VVP should contain material that can be used for this subsection of the UTP, including a Verification Cross Reference Matrix (VCRM) that relates each Verification Item to the method or methods planned for its verification. It is permissible to insert relevant material from the VVP into the STP, provided it is referenced appropriately. Alternatively, the STP developers may choose to leave the specific material out of the STP and refer to specific sections of the VVP that pertain to the test methods. The latter choice is recommended if the CTR reviewers are already familiar with the material in the project’s VVP. It is recommended that the STP developers consult with the CTR reviewers before deciding how to fill this subsection of the STP.

4.9.2. Section 5.2 – Test Environments

The subsection for Test Environments should describe the environments in which the tests will be performed. Demonstrate that the planned test environments comply with the project’s test environment requirements, as documented in the RAD.

A project may use the development environment to test the pre-operational system or it may choose to establish a separate test environment. Project constraints will usually determine this choice. For example, operations may request that the test environment be a clone of the operational environment, but cost factors may exclude establishing the development environment as an operational clone. In that case, the best solution may be to use a small operational clone environment as a separate test environment. A project may
also choose to perform its pre-operational code unit tests in the development environment and then perform its system integration tests in an operational clone environment. In any case, these choices should be explicitly stated as requirements for the test environment.

Test environment requirements and test plans should be developed iteratively, with communication between the developers. Typically, preliminary test environment requirements are established at the Project Requirements Review (PRR), driven by STAR standards and operational needs. There may be cases where a project’s development team determines that the preliminary test environment requirements are not ideal for their project. If this occurs, the development team can request an analysis and possible refinement of the test environment requirements. Nevertheless, the system test plan must comply with the approved test environment requirements at the time of the system test.

It is preferable to use the same test environment for the system test as was used for all unit tests. For cases where the test environments differ, the system test should include verification that the same inputs to each software unit results in identical outputs when the unit is run in the system test environment.

### 4.9.3. Section 5.3 – Validation of Requirements

The subsection for Validation of Requirements should describe the steps that are planned to validate the requirements. Requirements validation is concerned with ensuring that the requirements and requirements allocation provide a satisfactory balance between customer/user needs and expectations, NESDIS mission goals, technical feasibility, the available resources and external constraints.

- Basic requirements are validated by a demonstration that a balance has been established between customer/user needs and expectations, and constraints on the production, distribution and performance of products.
- Derived requirements are validated by a demonstration that they are the best set of requirements to satisfy the basic requirements.
- Requirements allocations are validated by a demonstration that the solution and design provides a feasible, satisfactory implementation for meeting the requirements.
- The plan can be a general plan that applies to all requirements and can also include specific activities that are pertinent to specific sets of requirements. These should be explicitly noted.
4.9.4. Section 5.4 – System Verification

The subsection for System Verification should describe how the system requirements will be verified. Verification is the formal process of confirming that the requirements specified for a system are satisfied by the completed system. Verification is customarily performed at the Unit-Layer first and then finalized at the System-Layer following product integration. Verification at the Unit-Layer is accomplished by unit tests. These are described in the UTP. Note that the STP does not address the unit tests and refer the reader to the UTP.

System verification is a comprehensive end-to-end test of the integrated product processing system and all of its components to ensure that all system requirements are satisfied. Describe the verification steps of the system test at a level of detail sufficient for a reviewer to be able to verify that the system test can achieve its purpose of verifying all system requirements. Typically, system verification will include the end-to-end execution of the software units.

Describe the planned sequence of test actions in sufficient detail that a reviewer can confirm that all system components listed in Section 4.1 are exercised, all test data listed in Section 4.2 is utilized, all planned test methods described in Section 5.1 are used as planned, and the planned output includes all product components listed in Section 4.2.

4.9.5. Section 5.5 – Validation of Operator Needs

The subsection for Validation of Operator Needs should describe the steps that are planned to ensure that the operator needs discussed in Section 2.2 of the STP are satisfied by the PPS. Each operator need that was itemized in Section 2.2 should be traceable to the steps described in this subsection. Adopt information from the project STP, which should be referenced.

Describe the planned sequence of test actions in sufficient detail that a reviewer can confirm that the requirements identified in Section 2.2 will be satisfied.
4.9.6. Section 5.6 – Validation of User Needs

The subsection for Validation of User Needs should describe the steps that are planned to ensure that the non-product user needs discussed in Section 2.1 of the STP are satisfied by the product processing system. The product-related user needs are of special importance, so are discussed in their own subsection. Each non-product user need that was itemized in Section 2.1 should be traceable to the steps described in this subsection.

Describe the planned sequence of test actions in sufficient detail that a reviewer can confirm that the requirements identified in Section 2.1 will be satisfied.

4.9.7. Section 5.7 – Validation of Products

The subsection for Validation of Products should describe the steps that are planned to ensure that the product-related user needs discussed in Section 2.1 of the STP are satisfied by the product processing system. Each product-related user need (e.g. product quality, product latency, product formats) that was itemized in Section 2.1 should be traceable to the steps described in this subsection.

Describe the planned sequence of test actions in sufficient detail that a reviewer can confirm that the product-related requirements identified in Section 2.2 will be satisfied.

4.10. Section 6 – Limitations and Risks

Note any conditions (e.g. lack of real sensor data) that may limit the ability of the system test to achieve its purpose of verifying system requirements, and validating the needs and expectations of users and operators.

Identify risks that are generated by these limitations. Identify and evaluate other risks to successful implementation of the system test plan. For each identified risk:

- Recommend a plan to mitigate the risk
- Note risk closure criteria
- Recommend actions to implement the risk mitigation plan.
- Note criteria to close actions
4.11. Section 7 – List of References

This section should consist of a List of References that includes all references cited in the document. Include all references deemed useful by the Product Team. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.
APPENDIX A. EXAMPLES

An example of an STP that follows the STAR standards and guidelines will be developed and placed in the STAR EPL PAR.
APPENDIX B. TEMPLATES

This appendix contains templates for specific pages and sections of the UTP.
B.1 Cover Page Template:

In this template, $<X> = 1.0$ for version 1, $<X> = 1.1$ for version 1 revision 1, $<X> = 2.0$ for version 2 etc. $<Project Name>$ should be the actual approved name of the Project.
B.2 Document Header Template:
In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc.

In this template, <Project Name> should be the actual approved name of the Project.

In this template, <Y> = the actual page number.

In this template, <Z> = the actual total number of pages

NOAA/NESDIS/STAR

UNIT TEST PLAN

Version: <X>

Date: <Date of Latest Signature Approval>

<Project Name>

Unit Test Plan

Page <Y> of <Z>

B.3 Document Cover Page Footer Template:

Hardcopy Uncontrolled

B.4 Document Footer Template:

Hardcopy Uncontrolled
B.5 Approval Page Template:

In this template, \( \langle X \rangle = 1.0 \) for version 1, \( \langle X \rangle = 1.1 \) for version 1 revision 1, \( \langle X \rangle = 2.0 \) for version 2 etc. \( \langle \text{Project Name} \rangle \) should be the actual approved name of the Project.

TITLE: \( \langle \text{PROJECT NAME} \rangle \) UNIT TEST PLAN VERSION \( \langle X \rangle \)

AUTHORS:

\( \langle \text{Lead Author} \rangle \)
\( \langle \text{Co-Author 1} \rangle \)
\( \langle \text{Co-Author 2} \rangle \)
\( \langle \text{etc.} \rangle \)

APPROVAL SIGNATURES:

\begin{tabular}{ll}
\hline
\text{Name of Project Development Lead} & \text{Date} \\
\text{Project Development Lead} & \text{<Actual Signature Date>} \\
\hline
\text{Name of Project Manager} & \text{Date} \\
\text{Project Manager} & \text{<Actual Signature Date>} \\
\hline
\text{Name of Agency Approver} & \text{Date} \\
\text{Agency} & \text{<Actual Signature Date>} \\
\hline
\end{tabular}
B.6 Version History Page Template:

In this template, <Project Name> should be the actual approved name of the Project.

---

<PROJECT NAME>
SYSTEM TEST PLAN
VERSION HISTORY SUMMARY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Code Test Review.</td>
<td>New Document</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for System Readiness Review</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B.7 Figure Caption Template:

Figure X.Y - <Figure caption in Arial regular 12 point font>

B.8 Table Title Template:

Table X.Y - <Table title in Arial regular 12 point font>
B.9  List of References Template:


END OF DOCUMENT